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Chapter 430

Mann-Whitney-Wilcoxon
Tests (Simulation)
Introduction
This procedure provides sample size and power calculations for one- or two-sided two-sample Mann-WhitneyWilcoxon Tests based on simulation. This test is the nonparametric alternative to the traditional two-sample t-test.
Other names for this test are the Mann-Whitney U test, the Wilcoxon-Mann-Whitney test, or Wilcoxon rank-sum
test.
The design corresponding to this test procedure is sometimes referred to as a parallel-groups design. This design
is used in situations such as the comparison of the income level of two regions, the nitrogen content of two lakes,
or the effectiveness of two drugs.
There are several statistical tests available for the comparison of the center of two populations. You can examine
the sections below to identify whether the assumptions and test statistic you intend to use in your study match
those of this procedure, or if one of the other PASS procedures may be more suited to your situation.

Other PASS Procedures for Comparing Two Means
Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be
used when the analysis of the data is performed. You should check to identify that the test procedure described
below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are
different, you may wish to use one of the other two-sample procedures available in PASS. These procedures are
Two-Sample T-Tests Assuming Equal Variance, Two-Sample T-Tests Allowing Unequal Variance, Two-Sample
Z-Tests Assuming Equal Variance, and Two-Sample Z-Tests Allowing Unequal Variance. The methods,
statistics, and assumptions for those procedures are described in the associated chapters.
If you wish to show that the mean of one population is larger (or smaller) than the mean of another population by
a specified amount, you should use one of the clinical superiority procedures for comparing means. Noninferiority, equivalence, and confidence interval procedures are also available.

Test Assumptions
When running a Mann-Whitney-Wilcoxon test, the basic assumptions are random sampling from each of the two
populations and that the measurement scale is at least ordinal. These assumptions are sufficient for testing
whether the two populations are different. If we can additionally assume that the two populations are identical
except possible for a difference in location, then this test can be used as a test of equal means or medians.
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Test Procedure
If we assume that the two populations differ only in location, with µ1 and µ2 representing the means of the two
populations of interest, and that δ = µ1 − µ 2 , the null hypothesis for comparing the two means (or medians) is

H 0 : δ = 0 . The alternative hypothesis can be any one of

H1 : δ ≠ 0
H1 : δ > 0
H1 : δ < 0
depending upon the desire of the researcher or the protocol instructions. A suitable Type I error probability (α) is
chosen for the test, the data is collected, and the data from both groups are combined and then ranked.
The Mann-Whitney test statistic is defined as follows in Gibbons (1985).

z=

W1 −

N1 ( N1 + N 2 + 1)
+C
2
sW

where
N1

W1 = ∑ Rank ( X 1k )
k =1

The ranks are determined after combining the two samples. The standard deviation is calculated as

sW =

N1 N 2 ∑ ( t i3 − t i )

N1 N 2 ( N1 + N 2 + 1)
i =1
−
12
12( N1 + N 2 )( N1 + N 2 − 1)

where ti is the number of observations tied at value one, t2 is the number of observations tied at some value two,
and so forth.
The correction factor, C, is 0.5 if the rest of the numerator of z is negative or -0.5 otherwise. The value of z is then
compared to the standard normal distribution.
The null hypothesis is rejected in favor of the alternative if,
for H 1 : δ ≠ 0 ,

z < zα / 2 or z > z1−α / 2 ,
for H 1 : δ > 0 ,

z > z1−α ,
or, for H 1 : δ < 0 ,

z < zα .
Comparing the z-statistic to the cut-off z-value (as shown here) is equivalent to comparing the p-value to α.
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Power Calculation
Simulation
Simulation allows us to estimate the power and significance level that is actually achieved by a test procedure in
situations that are not mathematically tractable.
The steps to a simulation study are
1. Specify how the test is carried out. This includes indicating how the test statistic is calculated and how the
significance level is specified.
2. Generate random samples from the distributions specified by the alternative hypothesis. Calculate the test
statistics from the simulated data and determine if the null hypothesis is accepted or rejected. Tabulate the
number of rejections and use this to calculate the test’s power.
3. Generate random samples from the distributions specified by the null hypothesis. Calculate each test statistic
from the simulated data and determine if the null hypothesis is accepted or rejected. Tabulate the number of
rejections and use this to calculate the test’s significance level.
4. Repeat steps 2 and 3 several thousand times, tabulating the number of times the simulated data leads to a
rejection of the null hypothesis. The power is the proportion of simulated samples in step 2 that lead to
rejection. The significance level is the proportion of simulated samples in step 3 that lead to rejection.

Generating Random Distributions
Two methods are available in PASS to simulate random samples. The first method generates the random variates
directly, one value at a time. The second method generates a large pool (over 10,000) of random values and then
draw the random numbers from this pool. This second method can cut the running time of the simulation by 70%.
As mentioned above, the second method begins by generating a large pool of random numbers from the specified
distributions. Each of these pools is evaluated to determine if its mean is within a small relative tolerance (0.0001) of
the target mean. If the actual mean is not within the tolerance of the target mean, individual members of the
population are replaced with new random numbers if the new random number moves the mean towards its target.
Only a few hundred such swaps are required to bring the actual mean to within tolerance of the target mean. This
population is then sampled with replacement using the uniform distribution. We have found that this method works
well as long as the size of the pool is the maximum of twice the number of simulated samples desired and 10,000.

Standard Deviations
Care must be used when either the null or alternative distribution is not normal. In these cases, the standard
deviation is usually not specified directly. For example, you might use a gamma distribution with a shape
parameter of 1.5 and a mean of 4 as the null distribution and a gamma distribution with the same shape parameter
and a mean of 5 as the alternative distribution. This allows you to compare the two means. However, although the
shape parameters are constant, the standard deviations, which are based on both the shape parameter and the
mean, are not.

A Note on Specifying the Difference in Means/Medians
When the difference in means is specified in this procedure, it is the assumed difference in means for power or
sample size calculations. It does not mean that the study will be powered to show that the mean difference is this
amount, but rather that the design is powered to reject the null hypothesis of equal means if this were the true
difference in means. If your purpose is to show that one mean is greater than another by a specific amount, you
should use one of the clinical superiority procedures for comparing means.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies whether you want to find Power or Sample Size (N1) from the simulation. Select Power
when you want to estimate the power of a certain scenario. Select Sample Size (N1) when you want to determine
the sample size needed to achieve a given power and alpha error level. Finding Sample Size (N1) is very
computationally intensive, and so it may take a long time to complete.

Test and Simulations
Alternative Hypothesis
This option specifies the alternative hypothesis, H1. This implicitly specifies the direction of the hypothesis test.
The null hypothesis is always H0: Diff = Diff0.
Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.
Possible selections are:
•

Difference ≠ Diff0
This is the most common selection. It yields a two-tailed test. Use this option when you are testing whether
the mean is different from a specified value Diff0, but you do not want to specify beforehand whether it is
smaller or larger. Most scientific journals require two-tailed tests.

•

Difference < Diff0
This option yields a one-tailed test. Use it when you want to test whether the true mean is less than Diff0.

•

Difference > Diff0
This option yields a one-tailed test. Use it when you want to test whether the true mean is greater than Diff0.
Note that this option could be used for a non-inferiority test.

Simulations
This option specifies the number of iterations, M, used in the simulation. As the number of iterations is increased,
the accuracy and running time of the simulation will be increased also.
The precision of the simulated power estimates are calculated from the binomial distribution. Thus, confidence
intervals may be constructed for various power values. The following table gives an estimate of the precision that
is achieved for various simulation sizes when the power is either 0.50 or 0.95. The table values are interpreted as
follows: a 95% confidence interval of the true power is given by the power reported by the simulation plus and
minus the ‘Precision’ amount given in the table.

430-4
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Mann-Whitney-Wilcoxon Tests (Simulation)
Simulation
Size
M
100
500
1000
2000
5000
10000
50000
100000

Precision
when
Power = 0.50
0.100
0.045
0.032
0.022
0.014
0.010
0.004
0.003

Precision
when
Power = 0.95
0.044
0.019
0.014
0.010
0.006
0.004
0.002
0.001

Notice that a simulation size of 1000 gives a precision of plus or minus 0.01 when the true power is 0.95. Also
note that as the simulation size is increased beyond 5000, there is only a small amount of additional accuracy
achieved.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.
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•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.
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•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
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The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size
Group 1 (and 2) Distribution|H0
Specify the distributions of groups 1 and 2 to be used in the simulations for finding the actual significance level.
These distributions also specify the value of the mean under the null hypothesis, H0. Usually, these two
distributions will be identical. However, if you are planning a non-inferiority test, the means will be different.
The parameters of the distribution can be specified using numbers or letters. If letters are used, their values are
specified in the boxes below. The value “M0” is reserved for the value of the mean under the null hypothesis.
Following is a list of the distributions that are available and the syntax used to specify them. Each of the
parameters should be replaced with a number or parameter name.
Distributions with Common Parameters
Beta(Shape1, Shape2, Min, Max)
Binomial(P, N)
Cauchy(Mean, Scale)
Constant(Value)
Exponential(Mean)
Gamma(Shape, Scale)
Gumbel(Location, Scale)
Laplace(Location, Scale)
Logistic(Location, Scale)
Lognormal(Mu, Sigma)
Multinomial(P1, P2, P3, ..., Pk)
Normal(Mean, Sigma)
Poisson(Mean)
TukeyGH(Mu, S, G, H)
Uniform(Min, Max)
Weibull(Shape, Scale)
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Distributions with Mean and SD Parameters
BetaMS(Mean, SD, Min, Max)
BinomialMS(Mean, N)
GammaMS(Mean, SD)
GumbelMS(Mean, SD)
LaplaceMS(Mean, SD)
LogisticMS(Mean, SD)
LognormalMS(Mean, SD)
UniformMS(Mean, SD)
WeibullMS(Mean, SD)

Details of writing mixture distributions, combined distributions, and compound distributions are found in the
chapter on Data Simulation and will not be repeated here.
Finding the Value of the Mean of a Specified Distribution
The mean of a distribution created as a linear combination of other distributions is found by applying the linear
combination to the individual means. However, the mean of a distribution created by multiplying or dividing
other distributions is not necessarily equal to applying the same function to the individual means. For example,
the mean of 4 Normal(4, 5) + 2 Normal(5, 6) is 4*4 + 2*5 = 26, but the mean of 4 Normal(4, 5) * 2 Normal(5, 6)
is not exactly 4*4*2*5 = 160 (although it is close).
Group 1 (and 2) Distribution|H1
Specify the distributions of groups 1 and 2 under the alternative hypothesis, H1. The difference between the
means of these two distributions will be the actual difference specified under H1.
The parameters of the distribution can be specified using numbers or letters. If letters are used, their values are
specified in the boxes below. The value “M1” is reserved for the value of the mean under the alternative
hypothesis.
A list of the distributions that are available and the syntax used to specify them is given above.

Effect Size – Distribution Parameters
M0 (Mean|H0)
These values are substituted for M0 in the distribution specifications given above. M0 is intended to be the value
of the mean hypothesized by the null hypothesis, H0.
You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1.
M1 (Mean|H1)
These values are substituted for M1 in the distribution specifications given above. Although it can be used
wherever you want, M1 is intended to be the value of the mean hypothesized by the alternative hypothesis, H1.
You can enter a list of values using the syntax 0 1 2 3 or 0 to 3 by 1.
Parameter Values (S, A, B)
Enter the numeric value(s) of the parameters listed above. These values are substituted for the corresponding letter
in all four distribution specifications.
You can enter a list of values for each letter using the syntax 0 1 2 3 or 0 to 3 by 1.
You can also change the letter that is used as the name of this parameter using the pull-down menu to the side.
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Options Tab
The Options tab contains simulation options.

Random Numbers
Random Number Pool Size
This is the size of the pool of random values from which the random samples will be drawn. Pools should be at
least the maximum of 10,000 and twice the number of simulations. You can enter Automatic and an appropriate
value will be calculated.
If you do not want to draw numbers from a pool, enter 0 here.

Reports Tab
The Reports tab contains settings about the format of the output.

Select Numeric Report Output
Show Inc’s & 95% C.I.
Checking this option causes an additional line to be printed showing a 95% confidence interval for both the power
and actual alpha and half the width of the confidence interval (the increment).
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Example 1 – Finding the Sample Size
Researchers wish to compare two types of local anesthesia to determine whether there is a difference in time to
loss of pain. Subjects will be randomized to treatment, the treatment will be administered, and the time to loss of
pain measured. The researchers would like to generate a sample size for the study with 90% power to reject the
null hypothesis of equal loss-of-pain time if the true difference is at least 3 minutes. How many participants are
needed to achieve 90% power at significance levels of 0.01 and 0.05?
Past experiments of this type have had standard deviations in the range of 1 to 5 minutes. It is anticipated that the
standard deviation of the two groups will be equal.
It is unknown which treatment has lower time to loss of pain, so a two-sided test will be used.
The researchers will be performing a Mann-Whitney-Wilcoxon test instead of the t-test, because it is anticipated
that the distribution of the two populations is not Normal. The researchers assume that the distribution shape that
most closely resembles the two populations is Tukey’s Lambda distribution with Skewness value 0.12 and
Elongation 0.07 (Tukey’s Lambda distribution adjusts the Normal distribution by a specified Skewness factor and
Kurtosis factor – you can examine the distribution with the Data Simulator tool, in the Tools menu).

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mann-Whitney-Wilcoxon Tests procedure window by expanding Means, then Two
Independent Means, then clicking on Nonparametric, and then clicking on Mann-Whitney-Wilcoxon Tests.
You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Find (Solve For) ...................................... Sample Size
Alternative Hypothesis ............................ Diff ≠ Diff0
Simulations ............................................. 2000
Power ...................................................... 0.90
Alpha ....................................................... 0.01 0.05
Group Allocation ..................................... Equal (N1 = N2)
Group 1 Distribution | H0 ........................ TukeyGH(M0 S A B)
Group 2 Distribution | H0 ........................ TukeyGH(M0 S A B)
Group 1 Distribution | H1 ........................ TukeyGH(M0 S A B)
Group 2 Distribution | H1 ........................ TukeyGH(M1 S A B)
M0 (Mean|H0) ......................................... 0
M1 (Mean|H1) ......................................... 3
S.............................................................. 1 to 5 by 1
A.............................................................. 0.12
B.............................................................. 0.07
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Mean Difference = Diff0.
H0 Dist's: TukeyGH(M0 S A B) & TukeyGH(M0 S A B)
H1 Dist's: TukeyGH(M0 S A B) & TukeyGH(M1 S A B)
Test Statistic: Mann-Whitney-Wilcoxon Test

Hypotheses: H0: Diff1 = Diff0; H1: Diff1 ≠ Diff0

Power N1/N2
0.947
8/8
(0.010) [0.937

H0
Diff0
0.00
0.956]

H1
Diff1
-3.00

Target
Alpha
0.010

Actual
Alpha
0.004
(0.003)

Beta
0.054
[0.002

M0
0.00
0.007]

M1
3.00

S
1.00

A
0.12

B
0.07

0.940
5/5
(0.010) [0.930

0.00
0.950]

-3.00

0.050

0.038
(0.008)

0.060
[0.029

0.00
0.046]

3.00

1.00

0.12

0.07

0.896
15/15
(0.013) [0.882

0.00
0.909]

-3.00

0.010

0.008
(0.004)

0.105
[0.004

0.00
0.013]

3.00

2.00

0.12

0.07

0.914
11/11
(0.012) [0.902

0.00
0.926]

-3.00

0.050

0.048
(0.009)

0.086
[0.039

0.00
0.057]

3.00

2.00

0.12

0.07

0.909
30/30
(0.013) [0.896

0.00
0.922]

-3.00

0.010

0.010
(0.004)

0.091
[0.006

0.00
0.014]

3.00

3.00

0.12

0.07

0.908
21/21
(0.013) [0.895

0.00
0.920]

-3.00

0.050

0.049
(0.009)

0.093
[0.040

0.00
0.058]

3.00

3.00

0.12

0.07

0.911
51/51
(0.012) [0.899

0.00
0.923]

-3.00

0.010

0.008
(0.004)

0.089
[0.004

0.00
0.012]

3.00

4.00

0.12

0.07

0.901
35/35
(0.013) [0.887

0.00
0.914]

-3.00

0.050

0.048
(0.009)

0.100
[0.038

0.00
0.057]

3.00

4.00

0.12

0.07

0.915
80/80
(0.012) [0.903

0.00
0.927]

-3.00

0.010

0.013
(0.005)

0.085
[0.008

0.00
0.018]

3.00

5.00

0.12

0.07

0.905
53/53
(0.013) [0.892

0.00
0.918]

-3.00

0.050

0.049
(0.009)

0.095
[0.040

0.00
0.058]

3.00

5.00

0.12

0.07

Notes:
Pool Size: 10000. Simulations: 2000. Run Time: 35.49 seconds.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 is the size of the sample drawn from population 1.
N2 is the size of the sample drawn from population 2.
Diff0 is the mean difference between (Grp1 - Grp2) assuming the null hypothesis, H0.
Diff1 is the mean difference between (Grp1 - Grp2) assuming the alternative hypothesis, H1.
Target Alpha is the probability of rejecting a true null hypothesis. It is set by the user.
Actual Alpha is the alpha level that was actually achieved by the experiment.
Beta is the probability of accepting a false null hypothesis.
Second Row: (Power Prec.) [95% LCL and UCL Power] (Alpha Prec.) [95% LCL and UCL Alpha]
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Summary Statements
Group sample sizes of 8 and 8 achieve 95% power to show a difference in means when there is a
difference of 3.00 between the null hypothesis mean difference of 0.00 and the actual mean
difference of -3.00 at the 0.010 significance level (alpha) using a two-sided
Mann-Whitney-Wilcoxon Test. These results are based on 2000 Monte Carlo samples from the null
distributions: TukeyGH(M0 S A B) and TukeyGH(M0 S A B), and the alternative distributions:
TukeyGH(M0 S A B) and TukeyGH(M1 S A B).

These reports show the values of each of the parameters, one scenario per row. Since these results are based on
simulation, they will vary from one calculation to the next.

Plots Section
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These plots show the relationship between the standard deviation and sample size for the two alpha levels.
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Example 2 – Comparing the Power to the T-Test for Normal Data
Suppose a new corn fertilizer is to be compared to a current fertilizer. The researchers need only show that there is
difference (increase) in yield with the new fertilizer. With 90 plots available, they would like to examine the
power of the test if the improvement in yield is at least 10 lbs.
Researchers plan to use a one-sided test with alpha equal to 0.05. Previous studies indicate the standard deviation
for plot yield to be 25 lbs. The distribution of plot yield values is unknown, so the researchers would like to see
the loss in power if the distribution turns out to be Normal and the Mann-Whitney-Wilcoxon test is used rather
than the standard t-test. The power for this scenario with the standard t-test is 0.594.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mann-Whitney-Wilcoxon Tests procedure window by expanding Means, then Two
Independent Means, then clicking on Nonparametric, and then clicking on Mann-Whitney-Wilcoxon Tests.
You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and
choosing Open Example Template.
Option

Value

Find (Solve For) ...................................... Power
Alternative Hypothesis ............................ Diff < Diff0
Simulations ............................................. 100000
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 45
Group 1 Distribution | H0 ........................ Normal(M0 S)
Group 2 Distribution | H0 ........................ Normal(M0 S)
Group 1 Distribution | H1 ........................ Normal(M0 S)
Group 2 Distribution | H1 ........................ Normal(M1 S)
M0 (Mean|H0) ......................................... 0
M1 (Mean|H1) ......................................... 10
S.............................................................. 25

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Mean Difference = Diff0.
H1 Dist's: Normal(M0 S) & Normal(M1 S)
Test Statistic: Mann-Whitney-Wilcoxon Test

Power N1/N2
0.580
45/45
(0.003) [0.577

H0
Diff0
0.0
0.583]

H1
Diff1
-10.0

Target
Alpha
0.050

Actual
Alpha
0.051
(0.001)

Hypotheses: H0: Diff1 = Diff0; H1: Diff1 < Diff0

Beta
0.420
[0.050

M0
0.0
0.052]

M1
10.0

S
25.0

The power of the Mann-Whitney test in this scenario is 0.580 (0.577, 0.583). This power is only slightly less than
the power of the t-test (0.594) for the corresponding scenario.
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Example 3 – Validation using Zhao, Rahardja, and Qu
Zhou, Rahardja, and Qu (2008) page 467 present a table of sample sizes and powers based on their formulas and
simulation results. In the example, the data considered follow a multinomial distribution, which heavily increases
the likelihood of ties. For the first set of scenarios, the power is 80%, the significance level is 0.05, and Group 2 is
assumed to have 53% of the total number of individuals in the sample. The ninth line has the two different
multinomial distributions defined as M(0.66, 0.15, 0.19) for Group 1 and M(0.55, 0.15, 0.30) for Group 2. The
total sample size is estimated at 502.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mann-Whitney-Wilcoxon Tests procedure window by expanding Means, then Two
Independent Means, then clicking on Nonparametric, and then clicking on Mann-Whitney-Wilcoxon Tests.
You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Find (Solve For) ...................................... Sample Size
Alternative Hypothesis ............................ Diff ≠ Diff0
Simulations ............................................. 10000
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Group Allocation ..................................... Enter R = N2/N1, solve for N1 and N2
R ............................................................. 1.12766
Group 1 Distribution | H0 ........................ Multinomial(0.66 0.15 0.19)
Group 2 Distribution | H0 ........................ Multinomial(0.66 0.15 0.19)
Group 1 Distribution | H1 ........................ Multinomial(0.66 0.15 0.19)
Group 2 Distribution | H1 ........................ Multinomial(0.55 0.15 0.30)

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Testing Mean Difference = Diff0. Hypotheses: H0: Diff1 = Diff0; H1: Diff1 ≠ Diff0
H0 Dist's: Multinomial(0.66 0.15 0.19) & Multinomial(0.66 0.15 0.19)
H1 Dist's: Multinomial(0.66 0.15 0.19) & Multinomial(0.55 0.15 0.30)
Test Statistic: Mann-Whitney-Wilcoxon Test

Power N1/N2
0.802 235/266
(0.002) [0.800

H0
Diff0
0.00
0.804]

H1
Diff1
-0.22

Target
Alpha
0.050

Actual
Alpha
0.050
(0.001)

Beta
0.198
[0.049

0.052]

The estimated sample size is 235 + 266 = 501, which is different than the article value by only one.
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